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  AAbboouutt  EEDDNNAA    
The Electronic Declaration software for National Authorities (EDNA) is a software tool, developed by 

the Technical Secretariat of the OPCW to provide assistance to National Authorities when compiling 

declarations pursuant to Article VI of the CWC, including the option of submitting those declarations 

in electronic format. 

With the help of EDNA 2.5 States Parties can prepare and submit declarations pursuant to Part VII 

(Schedule 2), Part VIII (Schedule 3) and Part IX (Other Chemical Production Facilities (OCPF) ) of the 

Verification Annex, including Aggregate National Data (AND) declarations. 

The Technical Secretariat will ensure that EDNA is kept current and updated to reflect applicable 

recommendations and decisions of the Secretariat for the Policy-making Organs of the OPCW. 

The Technical Secretariat will also provide assistance to Member States on the use of EDNA.  

 

  DDiissccllaaiimmeerr  
EDNA, including its source code is the intellectual property of the OPCW. 

EDNA may only be used for non-commercial purposes and cannot be sold, transferred or otherwise 

disposed of without the written permission of the OPCW. The software may be used by Member States 

for creating and storing declaration data to be submitted to the OPCW or for accessing and storing such 

information received from the OPCW.  

Any unilateral modification by the user to EDNA might cause incompatibility with future updates and 

therefore the OPCW will not assume any responsibility for the performance of EDNA following any 

such modification.  

It is the responsibility of the user to secure the system and its data from unauthorized access (physical 

or electronic). It is also the responsibility of the user to make data backups as necessary and secure the 

content of these data backups from unauthorised access.. 

The OPCW shall in no way be liable for any incidental, consequential and other damages resulting 

from the use of EDNA 
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 INFORMATION NOTE: VERSION 2.5 OF THE 

ELECTRONIC DECLARATION TOOL FOR 

NATIONAL AUTHORITIES (EDNA) 
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  CChhaannggeess  iinn  EEDDNNAA  VVeerrssiioonn  22..55  
 

EDNA Version 2.5 resolves some of the problems identified in earlier releases, and introduces several 

new features requested by States Parties. 

The installation of Version 2.5 offers the possibility of retaining the database created during installation 

of earlier versions as well as all the data contained in database. 

The key new features implemented in Version 2.5 (as compared to 2.1) comprise: 

New Features 

1. EDNA 2.5 enhances existing analytical reports, and introduces a new set of reports to assist 

States Parties in analysing data. Advanced features, such as data filtering, sorting, grouping 

and exporting are also supported. 

2. EDNA 2.5 introduces a new way of previewing declaration data, within the application and 

using rich filtering/sorting capabilities. This allows easier review of declaration data, 

especially in the case of large declarations, and improves the ability of States Parties to quality 

control their declarations prior to submission. 

3. In order to make warnings more visible and easier to detect, understand and correct, EDNA 

2.5 brings several improvements to the internal system of warnings and errors, both in the area 

of validation logic, as well as in the user interface, 

4. EDNA 2.5 introduces a new submission window for preparing the electronic declaration 

package for submission to the Technical Secretariat. This enhanced window allows improved 

quality control and is aimed at ensuring the completeness and accuracy of declarations, for the 

benefit of both the State Parties and the Technical Secretariat. 

5. EDNA 2.5 includes support for declaring “< threshold>” values for aggregate national data, , 

both in manual and automated AND mode, as per Decision C-7/DEC.14. 

6. Several bugs and issues, discovered during testing or reported by States Parties, have been 

fixed in Version 2.5, solutions included, inter alia: problems with amendments to previously 

submitted declarations; issues with installing and configuring EDNA on Windows 

Vista/Windows 7 operating systems; several corrections in the area of input data validation; 

and a number of minor cosmetic user interface improvements.  
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  DDiissttrriibbuuttiioonn  ooff  EEDDNNAA  

 

1. Member States can receive EDNA Version 2.5 on CD-ROM, provided to the respective Permanent 

Representative to the OPCW at OPCW Headquarters in The Hague, or transmitted by post to the 

Member State upon receipt of a written request from the Permanent Representative to the VIS Project 

Manager. The EDNA software can also be downloaded from the OPCW External Server under the 

section “EDNA/downloads”. 

 

2. There are two options for Member States opting to download the software from the OPCW External 

Server: 

a) Complete installation file for those installing EDNA for the first time. The file size is 

approximately 230 MB. 

b) Light installation for those who previously have installed EDNA. File size: approximately 

13 MB. 

For both options, the installation procedure is the same. 

 

3. Please inform the Project Manager VIS by email (vis@opcw.org) if you want to receive the new 

version of EDNA, and indicate your preferred option for receiving the software as per paragraph 1 

above. 

 

4. To run and install the new version, a Licence code is required that either will be provided together 

with the CD-ROM, or on request to Member States opting to download the software from the OPCW 

External Server. 

 

5. Please note that if you have already have installed EDNA Version 2.0 or 2.1 and have been provided 

a licence code from the Secretariat, you will NOT need a new licence code to install EDNA 2.5. 

 

 

  PPooiinnttss  ooff  CCoonnttaacctt  

 

Requests for copies of EDNA 2.5 and licence codes should be sent to: vis@opcw.org. 

 

mailto:vis@opcw.org
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 GET STARTED! 
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  SSooffttwwaarree  IInnssttaallllaattiioonn  

The EDNA software is intended to run under Windows©, either Windows XP Service 

Pack 3, Windows Vista or Windows 7 and is designed to run on a stand-alone 

workstation. EDNA requires the installation of SQL Server 2005 Express and .Net 

framework 4.0 (Both components are free and are included in the Installer package). 

 

Minimum Requirements: 

Processor: Pentium IV-Compatible or higher 

RAM: 512 MB or higher 

OS: Windows XP Service Pack 3 or higher on 32 Bits  

       Windows XP Service Pack 2 or higher on 64 Bits  

Screen resolution: 1024 X 768 

 

EDNA installer installs Microsoft SQL Server 2005 Express Edition with 

Service Pack 3 and Microsoft .Net Framework 2.0 and 4.0, if they are not 

detected on the machine. 

 

The installation of Microsoft SQL Server 2005 Express Edition SP3 is 

performed in Silent mode, thus no user interaction is required.  Advanced 

users may want to customise the installation (security settings etc…), and run 

the installation of Microsoft SQL Server 2005 Express SP3 separately from 

the EDNA CD-ROM.  Please be aware that this requires technical knowledge 

and may cause problems for EDNA if carried out incorrectly. OPCW does 

not support problems that may occur during the installation of the external 

components used by EDNA including .Net Framework and SQL Server 2005 

Express Edition.  Problems may be encountered if it is attempted to install 

EDNA on a computer which belongs to a security controlled environment.  

Please contact your IT support in the event of such problems. 

 

Please note that users need to have administrative rights to install EDNA 

software on a computer.  Without this authority the operating system will 

prevent the installation of EDNA.  In case of doubt, please contact IT 

support. 
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  GGeettttiinngg  SSttaarrtteedd    

1. Insert the EDNA CD-ROM 

2. The CD-ROM should automatically start the setup process. If it does not start 

automatically, run the file Setup.exe in the CD-ROM folder. 

3. The installer will automatically install any missing components. This requires 

no interaction from the user (except for agreeing to the licence agreement s). 

Depending on your environment, you may be requested to restart the 

computer during this step. This is normal behaviour and once 

windows starts up the installation wizard will resume.  

 

4. After the required components are installed, the EDNA installation process 

will start. 

5. Click “Next” on the Welcome Screen 

6. Select the folder where you would like to install EDNA. Click “Next”. 

7. Click “Next” on the “Confirm Installation” window. 

8. EDNA installation will be launched.  When the installation finishes, click 

“Close”. 

9. A shortcut will be added to the Desktop and Start Menu.   

 
 

10. To start the application and configure EDNA follow the instructions for your 

operating system. 

 

For all versions of Windows XP 

 

 
 

 

1. Double click on the EDNA 2.5 Icon. 
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For all versions of Windows Vista 

 

 

 

 

1.  

Holding the shift key 

 

Right-Click with your 

mouse the EDNA 2.5 icon  

 

2. A context menu will pop up, from the options, select 

. 

3. A confirmation window will appear, click the “Allow” button 

to allow the initial EDNA configuration to take place. 
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For all versions of Windows 7 

 

 

 

1.  

Holding the shift key 

 

Right-Click with your 

mouse the EDNA 2.5 icon  

 

2. A context menu will pop up, from the options, select. 

 

3. A confirmation window will appear, click the “Yes” button to 

allow the initial EDNA configuration to take place. 
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CCoonnffiigguurriinngg  EEDDNNAA  

 

After installation, users will be required to determine a number of settings before 

using EDNA for the first time/. 

One of the choices user will need to make is whether to host the EDNA Database on a 

personal workstation or on a network database. Depending on the selection, the 

application will behave in slightly different manner, as explained below: 

 

 EDNA Configuration with Local Database  

This continues to be the preferred EDNA installation method. Having the 

database onin the same workstations allows the application to provide backup 

and restore services that guarantee that your data is kept safe, as well as 

providing a straightforward solution that requires no involvement of the 

organisation’s IT department.  

 

 EDNA Configuration with Remote Database  
The use of a remote database server is being supported for organizations that 

require their data to be centralised normally utilise a remote database server 

supported by IT experts with database management and server maintenance 

expertise. For technical reasons EDNA is not able to perform automatic 

backup and restore of remote databases. This requires intervention from the IT 

experts in the organisation, and therefore this mode of installation is only 

recommended for organisations where database administration professionals 

are available. 

 

Options during configuration 

During the entire configuration process two options are available: 

 

 Installation Manual 

By clicking this option, the application will open the Installation Manual in PDF format using  

the default PDF reader. 

 

If the PDF reader is not installed, a free version is available from Adobe 

Systems, at http://get.adobe.com/reader/ 

 

 

 Reset Configuration 

By clicking this option, all previous configuration information is removed and the application 

re-starts the configuration wizard. 

 

http://get.adobe.com/reader/
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  FFiirrsstt  ttiimmee  ccoonnffiigguurraattiioonn  wwiitthh  LLooccaall  

DDaattaabbaassee  

 

Database Setup  

The first time the program runs, users will be prompted to setup the database to be 

used by the application. 

  

 

Local Machine 

Alphanumeric code denoting the name of the current machine on which the software 

is running. 

 
Server Name 

Enumerates all SQL Server instances available on the workstation. Select one of the 

database servers from the list  

The database server installed by default for EDNA ends with 

\SQLEXPRESS3. If users wish to use the default configuration, this server 

should be selected from the list. 

 

Logon to the Server 

Users can choose between Windows Authentication and SQL Server Authentication 
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to connect to the SQL Server (specified in Server Name). The default configuration is 

set to “use Windows Authentication”. Click on “Test Connection” to check if the 

application connects successfully. 

 
Create a Database 

Click on the “Create Database” button.  By default the database is named “EDNA”. If 

required the name can be changed by typing the new name in the “Create new 

database” box. If an error occurs a message will appear describing the error.  

Otherwise, the application will display a message indicating that the action was 

performed successfully and setup will proceed to the succeeding configuration step. 

 

When creating the new database, make sure to use a unique name. 

 

License Agreement  

If EDNA is not already installed on the workstation, the program will prompt the user 

to select the Country of the National Authority using the software and the license 

keys. 

 

1. Choose the State Party of the National Authority using the software, from the list. 

 

2. Enter the License Key provided to users by the OPCW Technical Secretariat and click on “Accept” 

 

If users already have an EDNA 2.0 or 2.1 serial key, this may be used as the 

license key for this version.
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Grant Access to Additional Users 

If the user has access permission rights on the workstation, the configuration wizard 

will present a screen prompting the user to give access to additional users for EDNA. 

 

The list on the left side of this window lists users who are granted access to the 

application. If a user who needs to access EDNA is not shown on this list, add the 

name by using the “Add new user” feature on the right hand side of the screen. 

Adding Local Machine users 

This default option assumes that the users to be added are listed on the local machine. 

To add a user, input the user name and click the “Add” button. If the operation is 

successful the user name should immediately appear in the list on the left hand side. 

 
Adding Domain users 

If the accounts in the organisation are managed in a Windows domain, click on the 

“Domain” option and specify the Domain name, then input the user name and click 

the “Add” button. If the operation is successful the user name should immediately 

appear in the list on the left hand side of the screen. 

 

If in doubt, to determine whether you should add Local or Domain users 

consult your organisation’s IT support. 
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Configuration is Complete 

Once the user has specified all the configuration settings. The application will display 

the following confirmation. 

 

 

Click “Finish” to apply the user settings, then restart EDNA. 

Once the application restarts the EDNA splash screen will appear.  
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  UUppggrraaddee  CCoonnffiigguurraattiioonn  wwiitthh  LLooccaall  

DDaattaabbaassee  

 

Database Setup  

The first time the program runs, the user will be prompted to setup the Database to 

be used by the application. 

  

 

Local Machine 

The name of the current machine the software is running on. 

 
Server Name 

The setup lists all SQL Server instances available in the workstation. Select from the 

dropdown list the server name that hosts the existing EDNA Database. 

 

The database server installed by default for EDNA ends with 

\SQLEXPRESS3. It is likely that this is the server for your existing 

database. 
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Logon to the Server 

Users can choose between Windows Authentication and SQL Server Authentication 

to connect to the SQL Server (specified in Server Name). The default configuration is 

to use Windows Authentication. Click on “Test Connection” to check if the 

application connects successfully. 

 
Use Database 

Select from the dropdown list of databases the existing EDNA database you wish to 

upgrade. By default the database is named “EDNA”. In this step of the configuration 

click on the “Use Database” button.  If an error occurs a message will appear 

describing the error.  Otherwise, the application will display a message indicating that 

the action was performed successfully and setup will proceed to the upgrade screen. 

 

Database Upgrade  

The configuration process will check if the database version is correct and, if 

necessary, will prompt the user to upgrade the database. 

 

EDNA detects the current version and the required version. After checking that the 

information is correct, click on “Upgrade”. 

 

Before upgrading, the configuration wizard will backup the current database, to 

provide the option of rollback to the previous version of EDNA. The system will then 

proceed with the upgrade. 
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License Agreement  

If upgrading from version 2.0 or above the configuration wizard reuses the country 

and serial keys of the existing installation.  In the event that the current version is not 

compatible with this, the program will prompt the user to select the country of the 

National Authority from the dropdown list, and to input the license key. 

 

3. Choose the State Party of the National Authority from the dropdown list. 

 

4. Enter the License Key provided by the Technical Secretariat of the OPCW and click on “Accept” 

 

If you already have an EDNA 2.0 or 2.1 serial key, you may use it as the 

licence key for this version.



21 

 

Granting Access to Additional Users 

If you have access permission rights on your workstation, the configuration wizard 

will present a screen prompting you to give access to additional users for EDNA. 

 

The list on the left side of this window shows users who are granted access to the 

application. If there is a user who needs to access EDNA but is not shown on this list, 

the name should be added using the “Add new user” feature located on the right hand 

side of the screen. 

Adding Local Machine users 

This is the default option and assumes that the users to be added are users on the local 

machine. To add a user, input the user name and click the “Add” button. If the 

operation is successful the user name should immediately appear in the list on the left 

hand side. 

 
Adding Domain users 

If your organisation manages accounts in a Windows domain, click on the “Domain” 

option and specify your Domain name, then input the user name and click the “Add” 

button. If the operation is successful the user name should immediately appear in the 

list on the left hand side. 

 

If in doubt, to determine whether you should add Local or Domain users 

consult your organisation’s IT support. 
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Configuration is Complete 

Once you have specified all the configuration settings. The application will display a 

confirmation. 

 

 

Click “Finish” to apply your settings, then restart EDNA. 

Once the application restarts you will see the EDNA splash screen.  
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  RRoollllbbaacckk  ttoo  PPrreevviioouuss  VVeerrssiioonn  wwiitthh  LLooccaall  

DDaattaabbaassee  

 

Step by Step 

Follow the step by step process below should a situation arise where you need to 

restore the previous version of EDNA in your workstation.  

 

By rolling back to the previous version of EDNA, all the information you 

have modified or added in EDNA 2.5 will be lost. The application will be 

rolled back to the state it was in before the version upgrade. 

 

1. Open the Restore Database window 

In the application menu, select Tools -> Database Tasks -> Restore Database. 

 

 

2. Restore the database backup performed during the upgrade process 

From the pick list, select the latest backup with the version number of your previous 

version of EDNA. Click “Restore database”. 
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Once the restore process is complete, a pop-up message will appear informing you 

that the application will restart. 

 

3. Confirm the database has been rolled back. 

When EDNA restarts you will be greeted by the Upgrade wizard. Close this window 

by clicking the “X” in the top right corner. 
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4. Uninstall EDNA 2.5 

 

    On Windows XP  

 

Open Add and Remove Programs from the Control Panel 

Go to Control Panel and select the “Add and Remove Programs” option. 

 

 

 

Uninstall EDNA 

To uninstall the program, select EDNA from the program list, click “Remove” and follow 

the instructions to remove the application  
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    On Windows Vista and Windows 7  

 

Go to Programs and Features  

Click on the start button and in the textbox that appears type “programs”. You should 

get a list like the one shown below. From the list click on “Programs and Features”. 

 

 
 

 

Uninstall EDNA  

To uninstall the program, select EDNA from the program list, click the “Uninstall” button 

and follow the instructions to remove the application. 
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5. Install your previous version of EDNA 

Once the uninstall process is finished, follow instructions from the manual relevant to 

the version of EDNA you wish to install. 

 

When installing the previous version of EDNA, in order to regain access to 

an exact replica of the data that existed prior to the upgrade to 2.5, you must 

ensure that the existing database is selected.  
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  FFiirrsstt  ttiimmee  ccoonnffiigguurraattiioonn  wwiitthh  RReemmoottee  

DDaattaabbaassee  

 

Database Setup  

The first time the program runs, you will be prompted to setup the database to be 

used by the application. 

  

 

Server Name 

The server name enumerates all SQL Server instances available on your workstation. 

To view a list of all the database servers available in the network, uncheck the “Show 

only local SQL server instances” option and click the “Refresh” button. When the 

installer is done searching open the Server Name dropdown list to select your remote 

database server.  

 

If you know the name of the remote server, you can also type it in the Server 

name list. 

 

 
Logon to the Server 

You can choose between Windows Authentication and SQL Server Authentication to 
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connect to your SQL Server (specified in Server Name). The default configuration is 

to use Windows Authentication. Click on “Test Connection” to check if the 

application connects successfully. 

 
Create a Database 

By default the database created is named EDNA. In this step of the configuration click 

on the “Create Database” button.  

 

When creating the new database, make sure you use a unique name. 

 

 

The IT Department needs to grant Create Database permissions to the 

EDNA user on the remote database server. 

 

Since your installation is remote, you will get the following warning: 

 

 

If you agree with the limitations of using a remote database click “Yes”. Otherwise 

click “No” and refer to the configuration section dealing with local databases. 

 

By using a remote database server some functionality of the application 

will not be available and maintenance tasks, such as Backup and Restore 

will require the involvement of your organisation’s IT Department. The 

remote database scenario is only recommended to organisations with the 

IT infrastructure and personnel to support it. 
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License Agreement  

If you do not already have EDNA installed on your workstation, the program will 

prompt you to select the Country of the National Authority using the software and the 

license key. 

 

5. Choose the State Party of the National Authority using the software from the list. 

 

6. Enter the License Key provided to you by the Technical Secretariat of the OPCW and click on 

‘Accept’ 

 

If you already have an EDNA 2.0 or 2.1 serial key, you may use it as the 

license key for this version.
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Grant Access to Additional Users 

If you are able to manage access permissions on your workstation, the configuration 

wizard will present a screen prompting you to give access to additional users for 

EDNA. 

 

The list on the left side of this window shows users who are granted access to the 

application. If there is a user who needs to access EDNA but is not shown on this list, 

the name should be added using the “Add new user” feature at the right hand side of 

the screen. 

Adding Local Machine users 

This is the default option and assumes that the users to be added are users on the local 

machine. To add a user, input the user name and click the “Add” button. If the 

operation is successful the user name should immediately appear in the list on the left 

hand side. 

 
Adding Domain users 

If the accounts in your organisation are managed in a Windows domain, click on the 

“Domain" option and specify your Domain name, then input the user name and click 

the “Add” button. If the operation is successful the user should immediately appear in 

the list on the left hand side. 

 

If in doubt, to determine whether you should add Local or Domain users 

consult your organisation’s IT support. 
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Configuration is Complete 

Once you have specified all the configuration settings. The application will display a 

confirmation. 

 

 

Click “Finish” to apply your settings and restart EDNA. 

Once the application restarts you will see the EDNA splash screen.  
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  UUppggrraaddee  ccoonnffiigguurraattiioonn  wwiitthh  RReemmoottee  

DDaattaabbaassee  

 

Database Setup  

The first time the program runs, you will be prompted to setup the database to be 

used by the application. 

  

 

Server Name 

The server name enumerates all SQL Server instances available on your workstation. 

To retrieve a list of all the database servers available in your network, uncheck the 

“Show only local SQL server instances” option and click the “Refresh” button. When 

the installer is done searching open the Server Name dropdown list to select your 

remote database server. 

 

If you know the name of the remote server, you can input it directly into the 

Server Name box. 
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Logon to the Server 

You can choose between Windows Authentication and SQL Server Authentication to 

connect to your SQL Server (specified in Server Name). The default configuration 

setting uses Windows Authentication. Click on “Test Connection” to check if the 

application connects successfully. 

 
Use Database 

Select the existing EDNA database from the list of databases you wish to upgrade. By 

default the database is named EDNA. In this step of the configuration click on the 

“Use Database” button.    

 

Since your installation is remote, you will get the following warning: 

 

 

If you agree with the limitations of using a remote database click “Yes”.  

 

By continuing to use a remote database server some functionalities of the 

application will not be available, and maintenance tasks such as Backup 

and Restore, will require the involvement of your organisation’s IT 

Department. The remote database scenario is only recommended for 

organisations with adequate IT infrastructure and personnel support. 

 

Database Upgrade  

The configuration process will check if your database version is correct. If not it will 

show the current version and the required version. After checking that this is correct, 

click on “Upgrade”. 
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By using a remote database, the configuration wizard is unable to backup the database 

before upgrading and the wizard will show the following message: 

 

  

 

It is highly recommended that, with the assistance of your IT Department, 

a backup is performed on the remote database before proceeding. 

Otherwise you will not be able to roll back the installation,  if required. 

 

Once you backup your database, click “No” to continue the upgrade process. 



36 

 

License Agreement  

If you are upgrading from version 2.0 or above the configuration wizard reuses the 

country and serial keys of your existing installation.  In the event that your current 

version is not compatible with this process, the program will prompt you to select the 

Country of the National Authority using the software and the license key. 

 

7. Choose the State Party of the National Authority using the software from the list. 

 

8. Enter the License Key provided to you by the Technical Secretariat of the OPCW and click on 

‘Accept’ 

 

If you already have an EDNA 2.0 or 2.1 serial key, you may use it as the 

license key for this version.
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Grant Access to Additional Users 

If you are able to manage access permissions on your workstation, the configuration 

wizard will present a screen prompting you to give access to additional users for 

EDNA. 

 

The list on the left side of this window shows users who are granted access to the 

application. If there is a user who needs to access EDNA but is not shown on this list, 

the name should be added using the “Add new user” feature located on the right hand 

side of the screen. 

Adding Local Machine users 

This is the default option and assumes that the users to be added are users on the local 

machine. To add a user, input the user name and click the “Add” button. If the 

operation is successful the user name should immediately appear in the list on the left 

hand side. 

 
Adding Domain users 

If the accounts in your organisation are managed in a Windows domain, click on the 

“Domain” option and specify your Domain name, then input the user name and click 

the “Add” button. If the operation is successful the user name should immediately 

appear in the list on the left hand side. 

 

If in doubt, as to whether you should add Local or Domain users, consult 

your organisation’s IT support. 
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Configuration is Complete 

Once you have specified all the configuration settings. The application will display a 

confirmation message. 

 

 

Click “Finish” to apply your settings and restart EDNA. 

Once the application restarts you will see the EDNA splash screen.  
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  RRoollllbbaacckk  ttoo  pprreevviioouuss  VVeerrssiioonn  wwiitthh  

RReemmoottee  DDaattaabbaassee  

 

Step by Step 

A situation might arise where you need to restore the previous version of EDNA on 

your workstation. Do this by following the step by step process below. 

 

By rolling back to the previous version of EDNA, all information modified 

or added in EDNA 2.5 will be lost. The application will be rolled back to 

the pre-upgrade content. 

 

1. Request for a restore of your database. 

In Remote Database mode, EDNA is not able to Backup/Restore your database 

automatically. To roll back to the previous version you should request your IT 

department to restore the backup performed prior to the upgrade to EDNA 2.5, or to 

the latest available backup from your previous installation. 

 

When using a remote database you should always request for a backup to 

be made prior to any application upgrade. EDNA is unable to do this 

automatically on your behalf.  

 

 
3. Confirm that the database has been rolled back. 

Open EDNA 2.5 and verify that you are greeted with the Upgrade configuration 

wizard. Close the window by clicking the “X” in the top right corner. 
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4. Uninstall EDNA 2.5 

 

    On Windows XP  

 

Open Add and Remove Programs from the Control Panel 

Go to Control Panel and select the “Add and Remove Programs” option. 
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Uninstall EDNA 

To uninstall the program, select EDNA from the program list, click “Remove” and follow 

the instructions to remove the application  

 

 
 

 

    On Windows Vista and Windows 7  

 

Go to Programs and Features  

Click on the start button and in the textbox that appears type “programs”. You should 

get a list like the one shown below. From the list click on “Programs and Features”. 
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Uninstall EDNA  

To uninstall the program, select EDNA from the program list, click the “Uninstall” button 

and follow the instructions to remove the application. 

 

 

 

5. Install your previous version of EDNA 

Once the uninstall process is finished, refer to the manual of the version of EDNA you 

wish to install and follow the instructions. 

 

To regain access to your data as it was prior to the upgrade to 2.5, 

please ensure that the existing database is selected when installing the 

previous version of EDNA. 
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 EDNA INTERFACE 
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  EEDDNNAA  MMoodduulleess  aanndd  WWoorrkkffllooww  

 

EDNA has six main modules for entering and managing declaration data:  

 OCPF 

 Schedule 2 

 Schedule 3 

 Aggregate National Data (Automatic and Manual Mode) 

 Chemicals Data 

 Plant Sites Data 

 

In addition to the modules for entering the requisite declaration data, there are a number of functions 

that are common for several modules. These include:  

 Comments Window 

 Confidentiality Settings 

 Warnings  

 Copy from Previous Declarations 

 Analytical Reports 

 

Note: 

When creating an AND declaration using the Manual Mode, information to be declared can be entered 

into the modules in any order. 

If using the Automated Mode for AND, the Schedule 2 and/or Schedule 3 Plant Site declaration must be 

completed first, using the Schedule 2 and/or Schedule 3 modules. Only then can additional detailed 

information such as specification of import/export per country or data on chemicals below the threshold 

be entered for that Plant Site in the AND module. 
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  UUsseerr  IInntteerrffaaccee  

The EDNA window typically has three panes: 

  The left Pane is the “Main Pane” for displaying and entering information for the current 

declaration.  Depending on the task, the “Main Pane” can be divided into several levels. 

  Top level: The list of Plant Sites to be declared. For AND in Automatic Mode other entities 

contributing to the information to be declared may also be displayed. For AND Manual Mode 

the list of chemicals is displayed. 

  Lower/middle level: Data entry for the item currently selected (Plant Site, Chemical or 

Import/Export Entity). This part may be sub-divided into tabs when display of all the data 

fields is required. This part can also display a list of chemicals or plants to be declared for a 

Plant Site or chemicals for AND in Automatic Mode. 

  Bottom level: As applicable, data entry for an item selected in the lists above. This part 

may be sub-divided into tabs when display of all the data entry fields is required. 

  The Top Right Pane is the “Previous Declarations Pane” that shows the history of the Plant Site, 

or a chemical in AND Manual Mode, if it was previously declared. The function for ‘copy data 

from previous declaration’ is located in this pane. 

  The Bottom Right Pane is the “Warnings Pane” that shows the validation result of the currently 

selected form (Plant Site or AND). 

  Below the main menu is the “Comments” button that opens a new window and provides the 

possibility of adding an internal comment and/or a comment to be sent to the OPCW, on the Plant 

Site currently selected. For AND, the corresponding function can be found in the ‘View Aggregate 

National Data’ pop-up window. 
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Menus 

File 

 New Declaration:  Opens the window to start a new declaration 

 Open Declaration:  Opens an existing declaration 

 Declaration Properties:  Opens the window for setting properties for the current declaration  

 Submit Declaration: Opens the Export window to export the current declaration to XML or 

HTML format, or to create the files containing the declaration to be submitted to the OPCW.  

 Preview Declaration:  Opens a printable version of the current declaration to view before printing 

 Advanced Preview Declaration:  Opens a printable version of the current declaration in advanced 

mode, to view before printing using the advanced sorting and filtering options 

 Exit: Exits the EDNA application. 

 

Data 

 OCPF: Switches to the OCPF declaration module 

 Schedule 2: Switches to the S2 declaration module 

 Schedule 3: Switches to the S3 declaration module 

 Aggregate National Data: Switches to the S3 declaration module 

 Chemicals Data: Switches to the module for managing the list of chemicals 

 Plant Site Data: Switches to the module for managing the list of plant sites 

 Reload data from the database: Refreshes the data on the screen by re-loading it from the 

database 

 

Tools 

 Import: Imports an Electronic Declaration to EDNA (typically the Electronic Declaration is 

provided by OPCW in a format that contains a previously submitted declaration or an Electronic 

Declaration created by another software)  

 Export: Opens the Export window, to export the current declaration to XML or HTML format, or 

generate the electronic declaration ZIP file to be submitted to the Technical Secretariat. 

 Languages: Switches between the languages available in EDNA 

 Database Tasks: Backs up and restores the EDNA database  

 Conversion Tool: Opens the tool convert files from CTFS to XML format. 

 Validation Tool: Opens the Validation tool. 

 Grant User Access Wizard: Allows the granting of access to EDNA for new users or users that 

were not configured during the initial setup. 

 Settings: Opens a dialog box where miscellaneous settings of EDNA can be changed, including: 

the country of the National Authority using EDNA; the start up module: defining the custom fields 

for Plant Sites; un-submitting a declaration already submitted; or translating EDNA to a 

user-defined language. 

 

Reports  

 Analytical Reports: Switches to the analytical reports module 

 Declaration Plant Sites by Regime: Switches to the analytical reports module and shows the 

summary breakdown report for the number of declared plant sites per regime in the current 

declaration 

 Schedule 2 Past Activities
1
: Switches to the analytical reports module and shows the summary of 

S2 activities declared in the current ADPA 

 Schedule 2 Anticipated Activities
2
: Switches to the analytical reports module and shows the 

summary of S2 activities declared in the current ADAA 

                                                 
1
 Only available if the currently open declaration is ADPA 
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 Schedule 2 Plants: Switches to the analytical reports module and shows the summary of S2 plants 

declared in the current declaration 

 Schedule 3 Past Activities
3
: Switches to the analytical reports module and shows the summary of 

S3 activities declared in the current ADPA 

 Schedule 3 Anticipated Activities
4
: Switches to the analytical reports module and shows the 

summary of S3 activities declared in the current ADAA 

 Schedule 3 Plants: Switches to the analytical reports module and shows the summary of S3 plants 

declared in the current declaration 

 OCPF Declaration Summary
5
: Switches to the analytical reports module and shows the summary 

of OCPF declared sites in the current declaration 

 OCPF Comparison with Previous Declaration
6
: Switches to the analytical reports module and 

shows a comparison report for comparing the OCPF declaration for the current and previous years  

 Trade Summary (Manual Mode)
7
: Switches to the analytical reports module and provides an 

overview of the aggregated national data import and export details 

 Aggregate National Data (Automatic Mode)
8
: Switches to the analytical reports module and 

shows the overview of the aggregated national data. 

 Trade Summary (Automatic Mode)
 9

: Switches to the analytical reports module and provides an 

overview of the aggregated national data import and export details. 

 

Help 

 Contents:  Displays the EDNA Help File Table of Contents 

 Search: Displays a dialog box that can be used to search the EDNA Help File 

 About: Displays an information window about EDNA, including its Licence terms 

                                                                                                                                            
2
 Only available if the currently open declaration is ADAA 

3
 Only available if the currently open declaration is ADPA 

4
 Only available if the currently open declaration is ADAA 

5
 Only available if the currently open declaration is ADPA 

6
 Only available if the currently open declaration is ADPA 

7
 Only available in manual mode 

8
 Only available in automatic mode 

9
 Only available in automatic mode 
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 START YOUR DECLARATIONS 
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  NNeeww  DDeeccllaarraattiioonn  

 

Where to find it? 

 File > New Declaration (Shortcut: Ctrl + N) 

 
 

 

Start a New Declaration 

The New Declaration window is used to start a new declaration. The declaration type is by default 

Annual Declaration of Past Activities (ADPA), but can be changed to Annual Declaration of 

Anticipated Activities (ADAA) when required. Specify the Year of the declaration to be added, set 

the default confidentiality classification for the declaration, select the aggregation method to be used 

in AND declarations, then click on “Add Declaration.” 

 

When the window is opened, it is automatically filled with the type of declaration, as 

well as a year for that declaration that is one year higher than the most recent 

declaration in the system. The type of declaration and year subsequently can be 

modified by the User. 

 

Users should enter a year for the selected type of declaration that is not already added to 

EDNA. 

 



50 

  DDeeccllaarraattiioonn  PPrrooppeerrttiieess  

Where to find it? 

 File > Declaration Properties 

The Declaration Properties window provides you with the ability to change the settings of the current 

Declaration.  This option will be disabled if the declaration has already been submitted. 

1. Year: Changing the year will not be accepted once the declaration has been created. 

2. Default Classification: This is the default classification that will be used, for any field in any 

form if there is no specific classification set at the Form or Field levels. 

3. Delete Declaration: Deletes the current declaration. 

4. Aggregation mode: The aggregation method is used for AND declarations. Changing the 

aggregation method may result in loss of any AND data already entered into the declaration. It is 

recommended to decide the aggregation mode for AND prior to any data entry. 

5. Adjust AND figures to schedule thresholds when submitting: Allows the user to configure 

how the import/export amounts of trade breakdown per country in the automatic AND will be 

represented when they are below the declaration threshold. If this box is checked, such amounts 

will be represented as per decision C-7/DEC.14 (in the form “< (relevant threshold activity)”. If 

the box is left unchecked, such amounts will be represented as exact quantities, as entered into 

the AND module. 

6. The dialog box also displays the National Authority country code. The code cannot be modified 

from this dialog box. Use the Tools->Settings menu point to change the country code setting. 

 

 

Deleting a Declaration will permanently remove all Plant Site and AND included in the 

declaration. 

 

Changing the aggregation method for AND, after having started to enter declaration data, 

may result in loss of the AND data already entered into the declaration. 
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  CChheemmiiccaallss  DDaattaa  

Where to find it? 

 Data > Chemicals Data 

Chemicals Data can also be accessed from other EDNA modules: 

 In the toolbar of the Schedule 2 and 3 modules, in the lower part of the “Main Pane” select the 

Chemicals tab then click on  

 In the toolbar in the AND module Manual Mode, click on Add Chemical to the 

Declaration. 

 In the AND module Automatic Mode, select a Plant Site/entity in the “Main Pane” and click 

on  in the lower part of the screen that contains the list of chemicals,  

The Chemicals Data module contains a database pre-loaded with chemicals extracted from the OPCW 

Handbook on Chemicals. This module provides the user with the ability to search chemicals by 

Chemical Name or CAS Number. The list of chemicals can be filtered, or a new chemical added by 

the user to the database, if not yet included on the list. 

If the list is opened from the Schedule 2 or the Schedule 3 module, the chemicals relevant to that 

module will be made available.  Opening the list from the AND module will display all chemicals 

contained in the database, irrespective of the schedule to which they pertain. 

Opening the Chemical List window from any of these modules also provides additional options for 

filtering the list of chemicals. 

 

 
 

The Chemicals data window (accessed from the Data menu command) 
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List of chemicals (chemical data accessed from the S2 module) 

 

Tool Bar 

 Declare Selected Chemicals
10

: Adds the checked chemical(s) to the current declaration. 

 Add New Chemical: Opens the “Add New Chemical” window for the purpose of adding a 

new chemical to the chemical data list 

 Filter Menu: Displays the filtering options for the list of chemicals. The user can filter the list 

to display only Schedule 2, Schedule 3, list of commonly traded chemicals, or the entire 

chemicals list. 

 Show only chemicals declared by: When accessing the list of chemicals from the Schedule 2, 

Schedule 3 or AND Module, additional filters are made available based on the declaration 

history of the chemicals in question, including the options ‘All Chemicals”, ‘All Plant Sites’, 

‘This Plant Site’ and a specific declaration. 

 Search Box: Filters the list of chemicals by CAS number or Chemical name. 

 

 

Filter to show chemicals declared in the ADPA 2010 

 

                                                 
10

 Only active if the list is accessed from the Schedule 2, Schedule 3 or AND Module. 
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Filter to show chemicals with a CAS number starting with ‘13’ 

 

Chemicals List 

This list displays the chemicals according to the current filter and search criteria. You can also select a 

‘hide’ option to remove from the display any chemicals that have already been added to the declaration. 

 

 Check Box
11

: check to select the chemical(s) to be added to the current declaration.  

 CAS Number: The Chemical Abstracts Service Number of the chemical 

 Chemical Name: The name used by the CWC to identify the chemical - unless the user has 

provided a preferred synonym. 

 Schedule: The schedule of the chemical. 

 Custom Field: The content of this column is selected from the context menu shown below. 

 

Context Menu 

 
 Declare Selected Chemicals

12
: Adds the checked chemical(s) to the current declaration.  

 Add New Chemical: Opens the Add New chemical window. 

 Edit Chemical: Opens the Edit Chemical window for the selected chemical. 

 Delete Chemical: Allows deletion of a chemical from the chemical data list
13

 

 Filtering Options (All/S2/S3/Commonly traded): These options are displayed in the toolbar. 

 Additional column: Provides options for the information on the chemical to be displayed in 

an additional left-hand column. The following options can be selected: CAS Name, Molecular 

Formula, HS Code or OPCW Key. 

 

                                                 
11

 Only active if the list is accessed from the Schedule 2, Schedule 3 or AND Module. 
12

 Only active if the list is accessed from the Schedule 2, Schedule 3 or AND Module. 
13

 Only possible for manually added chemicals. Pre-loaded chemicals cannot be deleted. 
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The changes you make to the layout of the Chemicals List, including the additional 

column and the filter option, are saved and loaded the next time you open the program 

 

Adding a new chemical to the Chemicals List 

 

Where to find it? 

In the Chemicals List window, either click Add New Chemical in the toolbar, or right-click on the 

list and click “Add New Chemical.” 

The “Add New Chemical” window is used to update the Chemicals database, in Edit mode or Add 

mode. When adding a chemical, the user can also enter all information relevant to the chemical. 

However, if the chemical was in the list preloaded with the software, only the HS code or the 

synonym can be modified, using the Edit mode. 

 

 CAS Registry Number: The CAS Number of the chemical 

 CAS Registry Name: The name used by CAS to identify the chemical 

 Chemical Name: The chemical name to be shown in the declaration. For chemicals preloaded 

in EDNA, the chemical name corresponds to the nomenclature used by the CWC 

 Molecular formula: The molecular formula of the chemical 

 OPCW Key: An internal key used by OPCW to identify chemicals with no assigned CAS 

number 

 HS Code: The Harmonised System code of the chemical. This value may be changed, in 

accordance of national legislation. 

 Structure: Currently not in use. For information see “Handbook of Chemicals”.  

 Schedule: The schedule of the chemical in accordance with the CWC. 

 Preferred name: Chemical synonym – an EDNA user-defined alternative name for the 

chemical. If a Preferred Name is defined, this will be used instead of the Chemical Name in 

the declaration. 

 

For preloaded chemicals, only the HS Code and Preferred Name field may be changed. 

 

 

If a Preferred name is provided for a chemical by the user, the former will be used as the 

chemical name in the declaration. 
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Window for adding a new chemical 
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  PPllaanntt  SSiitteess  DDaattaa  

Where to find it? 

 Data > Plant Sites Data 

Plant Sites Data can also be accessed from other modules of EDNA: 

 In the Schedule 2, Schedule 3, AND (Automatic Mode) and OCPF modules, click on Add 

Plant Site to Declaration in the “Main Pane” toolbar  

Opening the Plant Site module, or accessing the list of Plant Sites from the AND module using 

Automatic mode, will display all Plant Sites by default. To facilitate finding specific Plant Sites there 

are a number of options for filtering the information displayed 

Opening the Plant Site list from the Schedule 2, Schedule 3 or OCPF module will display only the 

Plant Sites that belong to that schedule. Additional options exist for filtering the information 

displayed. 

The Plant Sites Data window contains the list of Plant Sites added by the National Authority.  The list 

is empty when EDNA is first installed, and plant sites need to be added to the list.  The Plant Sites 

Data module can be used to maintain a complete list of Plant Sites, including those that fall below the 

declaration threshold. 

The Plant Site Data modules can also be used to maintain information on entities that only provide 

data for the compilation of the AND declaration, including traders or other data providers such as 

customs authorities. In EDNA these types of facilities are called “Import/Export entities”. 

 

Plant Sites Data pane with the pop-up window for adding a new plant site 
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Tool Bar 

 Declare Selected Plant Sites
14

: Adds the checked Plant Site(s) to the declaration 

 Add New Plant Site: Opens the Add New Plant Site window 

 Search Box: Searches the list of Plant Sites by Plant Site name or code 

 Filter: Displays only those Plant Sites that are declared in the specified declaration
15

 

 

Plant Sites List 

This list displays the list of Plant Sites added to the database. The option exists to hide Plant Sites that 

have already been added to the declaration. 

 

 Check Box: Check to select a Plant Site to be added to the current declaration.
16

. 

 Code: The code of the Plant Site.  

Note: If a Plant Site belongs to more than one schedule, it is highly 

recommended that the same Plant Site code be used for the different schedules. 

Ensure that the Plant Site code is unique, as duplicate codes that have already 

been assigned to another Plant Site under the same schedule will be rejected by 

EDNA. 

 Plant Site Name: The name of the Plant Site. 

 Schedule: The schedule to which the Plant Site belongs, or “Import/Export entity” for 

information on entities other than Plant Sites, provided for AND declaration s. 

 

Context Menu 

 Declare Selected Plant Sites
17

: Adds the checked Plant Sites to the current declaration.  

 Add Plant Site: Opens the Add New Plant Site window 

 Edit Plant Site: Opens the Edit Plant Site window for the selected Plant Site 

Note: Editing the information for a Plant Site will not affect Plant Site 

information contained in a declaration already submitted. Plant Site details will 

be only be updated in declarations that have yet to be submitted 

 

 Delete Plant Site: Deletes the selected Plant Site from the list. Note that a Plant Site can only 

be deleted if it has not been submitted in any previous declaration 

 Schedule specific filters: With the help of these menu points, Plant Sites that belong to a 

specific schedule can be filtered out from the complete list 

 Additional column: Provides an option for Plant Site information to be displayed in the left-

hand column. The following fields are available: Owner, Street Address, City or Province of 

the Plant Site. 

 

The changes you make to the layout of the Plant Sites List, including the additional 

column, are saved and loaded the next time the program is launched. 

 

Adding new Plant Sites 

Clicking on the button Add New Plant Site will open a dialog box showing Plant Site details. 

Users may add Plant Sites with a specific Schedule or Export/Import entities with no Schedule 

defined.  The latter entities are only used for declaring Import and Export for AND in automatic 

aggregation mode, and cannot be included in any Plant Site declaration. 

                                                 
14

 Only active if the list of Plant Sites is accessed from the Schedule 2, Schedule 3, OCPF or AND Module 
15

 Only active if the list of Plant Sites is accessed from the Schedule 2, Schedule 3, OCPF or AND Module 
16

 Only active if the list of Plant Sites is accessed from the Schedule 2, Schedule 3, OCPF or AND Module – Automatic mode. 
17

 Only active if the list of Plant Sites is accessed from the Schedule 2, Schedule 3, OCPF or AND Module – Automatic Mode. 
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Editing Plant Site information 

Plant Site information can be edited by: modifying the information stored in the “Plant Site Data” 

module, through the Context Menu > Edit Plant Site; or by clicking Edit Plant Site Info in the Main 

Pane and by modifying the > Plant Site Info in the Schedule2, Schedule 3 or OCPF module. 

If working in Amendment Mode, with a declaration marked as “submitted,” the option of “Edit Plant 

Site Info” is not available under the Plant Site Info tab in the “Main Pane” and any changes made will 

not be stored in the Plant Site Data module. Plant Site information can be edited directly in the 

respective data field, however the changes will apply only to the current amended declaration, and 

will not impact any other declarations stored in EDNA..  

The opposite also applies: editing Plant Site information for Plant Sites will not affect information 

contained in a declaration already submitted. 

 

Custom Fields 

When creating or editing a new Plant Site users have the option of providing additional information 

for the Plant Site for local use only, and not to be submitted as part of the declaration. These “Custom 

Fields” are defined from the main menu line through: Tools -> Settings -> Tab ‘Plant Sites’. 

Users can create and name as many custom fields as required. Typical information to be stored locally 

can include extended contact information e.g. contact person(s), telephone number, email address etc. 

 

Filters 

 

 

Filter to show Plant Sites declared in the ADPA 2010 
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Filter to show Plant Sites with a name beginning with ‘Che’ 
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  SScchheedduullee  22  MMoodduullee  

 

Where to find it? 

 Data > Schedule 2 

The Schedule 2 module is used to add Schedule 2 Plant Sites to a declaration and to enter the relevant 

declaration data 

This module maintains a list of Schedule 2 Plant Sites currently added to the declaration. When a 

Plant Site is  selected from the “Main Pane”, the information related to that Plant Site is displayed, 

together with the declaration history and any ‘warnings’ pertaining to the site 

Once a Plant Site is selected, the lower part of the “Main Pane” displays three tabs: “Plant Site Info”, 

“Chemicals” and “Plants Info”. 

The “Plant Site Info” tab displays information for the Plant Site. This information can be edited and 

saved in the “Plant Site Data” 

Chemicals produced, processed or consumed at the Plant Site can be added by using the “Chemicals” 

tab. After selecting a chemical, four sub-tabs are displayed, to allow for the entry of the relevant 

information to be declared 

Information about the plants at the Plant Site can be entered from the “Plants Info” tab.  After 

selecting a plant, data can be entered by clicking on the relevant sub-tabs 

 

Schedule 2 Plant Site declaration window 
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Tool Bar 

  Add Plant Site to Declaration : Opens the Plant Sites list to add a Plant Site to the current 

declaration. 

  Remove Plant Site from Declaration : Deletes the Plant Site currently selected from the 

list of sites to be declared. 

  Comments: Opens the comments window for entering comments that are to be attached to 

the Plant Site currently selected. 

 

List of Schedule 2 Plant Sites in the declaration 

The top level of the “Main Pane” shows the Schedule 2 Plant Sites added to the current declaration. 

 Code: The Plant Site code 

 Plant Site Name: The name of the Plant Site 

 Warnings: The number of warnings/errors identified by the system in relation to the Plant 

Site. 

 

SStteepp  bbyy  SStteepp::  HHooww  ttoo  ddeeccllaarree  aa  SScchheedduullee  22  PPllaanntt  SSiittee  

1. Open the Schedule 2 module (Data > Schedule 2) 

2. Click on Add New Plant Site in the toolbar. The Plant Sites list will be opened 

3. When running EDNA for the first time, or when declaring a Plant Site not yet contained in the 

list of Plant Sites, click Add Plant Site to enter the new Plant Site information and add it to 

the list 

4. Check the Plant Sites that you want to declare. Search for a specific Plant Site using its code or 

name and/or select a previous declaration 

5. Click on Declare Selected Plant Sites  in the toolbar  

6. The selected Plant Sites are added to the list of declared Plant Sites. Close the Plant Sites List 

window 

7. In the “Main Pane”, select a Plant Site from the list 

8. Click on the tabs and sub-tabs in lower land bottom levels of the “Main Pane” to navigate 

through the different elements of the Schedule 2 Plant Site declaration. Enter the information 

related to the selected Plant Site 

9. On the “Chemicals” tab, chemicals produced at the Plant Site can be added by pressing the  

button, or removed using the  button.  After selecting the chemical, relevant information on 

production, processing, consumption, import and/or export can be entered by clicking on the 

respective sub-tabs 

10. Information about the plants at the Plant Site can be entered from the “Plants Info” tab. Plants 

can be added by pressing the  button, or removed by the  button.  After selecting a plant, 

relevant information can be entered after clicking on the respective sub-tabs 

Note: The warnings displayed in the Warnings List will help to ensure that all required 

information has been entered and that it is logically consistent 
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Schedule 2 Plant Site declaration window- Adding a Plant Site to the declaration 

 

Schedule 2 Plant Site declaration window- Adding a Chemical to a S2 plant site 

 

Remember to set the correct unit of 

weight when entering amounts of 

chemicals. 

 

 
      Setting unit of weight  

  for amounts of chemicals 
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  SScchheedduullee  33  MMoodduullee  

 

Where to find it? 

 Data > Schedule 3 

The Schedule 3 module is used to add Schedule 3 Plant Sites to a declaration, and to enter the relevant 

declaration data 

This module maintains a list of Schedule 3 Plant Sites currently added to the declaration. When a 

Plant Site is selected from the “Main Pane”, the information related to that Plant Site is displayed, 

together with the declaration history and any warnings that may exist 

Once a Plant Site is selected, the lower part of the “Main Pane” displays three tabs: “Plant Site Info”, 

“Chemicals” and “Plants Info” 

The “Plant Site Info” tab displays the information for that Plant Site. The information can be edited 

and saved in “Plant Site Data” 

Chemicals produced at the Plant Site can be added via the “Chemicals” tab. Select a chemical and add 

the required information  

Information about the plants at the Plant Site can be entered via the the “Plants Info” tab.  After 

selecting a plant, any relevant information can be entered by clicking on the two sub-tabs 

 

Schedule 3 Plant Site declaration window 
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Tool Bar 

 Add Plant Site to Declaration: Opens the Plant Sites list to add a Plant Site to the current 

declaration. 

 Remove Plant Site from Declaration: Deletes the currently selected Plant Site from the 

list of sites to be declared. 

 Comments: Opens the comments window for entering comments that are to be attached to 

the Plant Site currently selected. 

 

List of Schedule 3 Plant Sites in the declaration 

The “Main Pane” shows the Plant Sites added to the current Schedule 3 declaration. 

 Code: The Plant Site code 

 Plant Site Name: The name of the Plant Site 

 Warnings: The number of warnings/errors identified by the system in relation to the Plant 

Site. 

 

   SStteepp  bbyy  SStteepp::  HHooww  ttoo  ddeeccllaarree  aa  SScchheedduullee  33  PPllaanntt  SSiittee  

1. Open the Schedule 3 module (Data > Schedule 3) 

2. Click on Add New Plant Site in the toolbar. The Plant Sites list will be opened 

3. When running EDNA for the first time, or when declaring a Plant Site not yet included in the 

list of Plant Sites, click Add Plant Site to enter the new Plant Site information and add it to 

the list 

4. Check the Plant Sites that you want to declare. You can search for a specific Plant Site using 

its code or name and/or select a previous declaration 

5. Click on Declare Selected Plant Sites  in the toolbar  

6. The selected Plant Sites will be added to the list of declared Plant Sites. Close the Plant Sites 

List window 

7. In the “Main Pane”, select a Plant Site from the list 

8. Use the tabs and sub-tabs in the lower and bottom levels of the “Main Pane” to navigate 

through the different elements of the Schedule 3 Plant Site declaration. Select a Plant Site and 

enter any relevant information 

9. Using the “Chemicals” tab, chemicals produced at the Plant Site can be added by pressing the 

 button, or removed by the  button.  After selecting a chemical, relevant information can 

be entered after clicking on the active sub-tabs 

10. Information about the plants at the Plant Site can be entered from the “Plants Info” tab. Plants 

can be added by pressing the  button, or removed by the  button.  After selecting a plant, 

relevant information can be entered after clicking on the relevant sub-tabs 

Note: The warnings displayed in the Warnings List will help to ensure that all information has been 

entered and that it is logically consistent 
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Adding a Schedule 3 Plant Site to the Declaration 

 

 

Adding a Chemical to a Schedule 3 Plant Site 
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  AANNDD  MMoodduullee  ––  MMaannuuaall  aaggggrreeggaattiioonn  

mmooddee  

 

Where to find it? 

 Data > Aggregate National Data - by chemical (manual mode) or shortcut: Ctrl + A 

Please note that this module is only available if manual aggregation mode was selected 

in the “Declaration Properties” window when the declaration was created.  If the 

current aggregation method is set to automatic, please refer to the section AND Module 

– automatic mode. 

The AND (Aggregate National Data) module is used to add AND information for Schedule 2 and 

Schedule 3 chemicals (corresponding to Form 2.1 or 3.1). The Module also contains the quantitative 

specification of Import and Export information for each country involved (corresponding to Form 

2.1.1 or 3.1.1). Please note that this version of EDNA does not support the declaration of transfers of 

Schedule 1 Chemicals. 

The AND module maintains the list of chemicals to be included in the declaration of AND. When a 

chemical is selected in the “Main Pane”, the related AND information is displayed in the lower part of 

that pane, together with panes showing the declaration history and any warnings. 

 

 

AND window - Manual Aggregation Mode.  Remember to set the correct unit of weight! 

 



67 

 

Tool Bar 

 Add Chemicals to the Declaration:  Opens the chemicals list to add a chemical to the 

current AND module. 

 Delete Chemical from the Declaration:  Deletes the AND form of the selected chemical 

from the current declaration. 

 Comments: Opens the window for comments to be attached to the AND form currently 

selected. 

 

AND Forms List 

The “Main Pane” shows the chemicals added to the current AND module. 

 CAS Number: The CAS Number of the chemical. 

 Chemical Name: The name of the chemical. 

 Schedule: The Schedule of the chemical. 

 The number of warnings associated with the selected AND record. If this field is empty, there 

are no warnings and the record is considered by the system to be correct. 

 

   SStteepp  bbyy  SStteepp::  HHooww  ttoo  ddeeccllaarree  aa  CChheemmiiccaall 

1. Open the AND module Data > Aggregate National Data - by chemical (manual mode) or 

shortcut: Ctrl + A 

2. Click on Add Chemicals to Declaration in the toolbar. The Chemicals list will be opened 

3. Check the Chemicals to be declared. You can filter the list or search for a specific chemical 

using the CAS Number, Chemical Name or previous declaration 

4. Click on Declare Selected Chemicals in the toolbar 

5. The selected chemicals will be added to the list of Chemicals included in AND in the “Main 

Pane”. Close the Chemicals List window 

6. In the “Main Pane”, select a chemical from the list by clicking on the required name 

7. In the lower part of the “Main Pane”, enter the AND declaration information relating to the 

selected chemical. Warnings will be provided if the sum of the individual transfers do not 

match the aggregate amounts for import and export 
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AND window Manual Aggregation Mode - adding a chemical 
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  AANNDD  MMoodduullee  ––  AAuuttoommaattiicc  mmooddee  

Where to find it? 

 Data > Aggregate National Data – by facility (automatic mode) or Shortcut: Ctrl + A 

Please note that this module is only available if automatic aggregation mode was 

selected in the “Declaration Properties” window when the declaration was created.  If 

the current aggregation method is set to manual, please refer to the AND Module – 

manual aggregation mode section.  

The AND (Aggregate National Data) module is used to add AND information for Schedule 2 and 

Schedule 3 chemicals (corresponding to Form 2.1 or 3.1).  This module also contains the quantitative 

specification of Import and Export information for each country involved (corresponding to Form 

2.1.1 or 3.1.1). Please note that this version of EDNA does not support the declaration of transfers of 

Schedule 1 Chemicals. 

In automatic aggregation mode AND data is aggregated automatically based on production (for 

Schedule 2 also processing and consumption), as well as on export and import data declared for 

individual facilities.  There is no need to manually sum up the declared data per chemical and by trade 

relation: this activity will be performed automatically by EDNA when the declaration data is 

calculated. 

The ”Main Pane” displays the Plant Sites/facilities included in the declaration. The chain link 

symbol displayed to the left of the name of a Plant Site indicates that the Plant Site was declared 

in the Schedule 2 or Schedule 3 part of the declaration, and has been included automatically by 

EDNA for declaration of the production (for Schedule 2 also processing and consumption), import 

and/or export activities of the facility. A  symbol displayed to the left of the name of a facility 

indicates that the facility has been added manually in the AND module (i.e. these facilities were 

included in the AND declaration only, but are not included in the Schedule 2, Schedule 3 or OCPF 

Plant Site declaration). 

The lower part of the “Main Pane” contains the list of chemicals produced (for Schedule 2 also 

processed and consumed), imported and/or exported by the facility selected. The chain link 

symbol displayed in front of the name of the chemical indicates that the chemical has been 

copied from the Schedule 2 or Schedule 3 Plant Site declaration. Chemicals added manually in the 

AND module will have a   symbol displayed in the left-hand column.   

 

Entering AND data for declared Plant Sites 

Facilities with the chain link symbol displayed in front of their name are copies, linked to an 

original entry, and therefore can only be removed from the list of facilities in the AND module by 

removing them from the Plant Site declarations in which they were originally entered. 

New chemicals can be added manually to the list of chemicals for the selected Plant Site by clicking 

on the  button to the right of the list of chemicals in the lower part if the “Main Pane”. Chemicals 

added manually in the AND module will have a  symbol displayed in the left-hand column of the 

list of chemicals. 

Chemicals added manually to a declared Plant Site in the AND module are not included in the 

declaration of the Plant Site, within the Plant Site declaration. 

Chemicals added manually to the list can be removed by selecting the chemical name and clicking on 

the  button. Chemicals with the chain link symbol displayed in front of their name can only be 

removed by removing them from the Plant Site declarations in which they were originally entered. 
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The bottom part of the “Main Screen” is used to enter data pertaining to the chemicals selected for the 

facility. Detailed information is pre-filled for chemicals included in the Plant Site declaration, and the 

respective field greyed out. The information to be added varies according to the Schedule and depends 

on whether or not the chemical has been included in the declaration of a Plant Site (“above 

threshold”). 

 

 

 

AND window Automatic Aggregation Mode 

 

Entering AND data for non-declared Plant Sites or an Import/Export Entity 

New facilities can be added to the list of facilities in the AND module by clicking Add new 

facility., Plant Sites or Import/Export Entities, added manually to the AND module will have the  

symbol displayed in the left-hand column in the list of facilities included for the calculation of AND.  

Facilities included manually in the AND declaration will not be declared as Plant Sites as such; 

however, their relevant activities will be included in the aggregation of AND. 

Facilities included manually in the list can be removed by the  Remove facility.  Please note that 

facilities can only be removed if all chemical activities related to them have already been removed. 

Chemicals can be added to the list of chemicals for the respective facility by selecting the facility and 

clicking on the button to the right of the list of chemicals in the lower part of the “Main Screen”. 

The chemicals added will have the  symbol displayed in the left-hand column in the list of 

chemicals. Chemicals included in the list can be removed by selecting the chemical(s) and clicking on 

the  button. 

The bottom part of the “Main Pane” is used to enter data for a selected chemical for a specific facility. 

The information to be added varies depending on the Schedule. 
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AND window Automatic Aggregation Mode – adding a new facility 

 

 

Tool Bar 

 Add new Facility: Opens the list of facilities in order to add new facility/facilities to the 

AND declaration. 

 Remove facility:  Removes the selected facility from the AND declaration.  This option is 

available only if all chemicals associated with the facility have already been removed and the 

facility has not automatically been carried over from the Plant Site declaration. 

 View Aggregate National Data: Displays the AND data aggregated by EDNA.  This 

feature can be used to check the final aggregated numbers that will be included in the 

declaration. 

 

List of activities included in AND 

The top part of the “Main Pane” shows the facilities added to the AND module. 

 

 Symbol in front of the facility name: The chain link symbol indicates that the facility has 

been copied automatically from the Plant Site declaration. The manually added  symbol 

indicates that the facility has been added manually to the AND declaration, and not included 

in the Plant Site declaration. 

 Code: The code of the facility. 

 Facility name: The name of the facility 

 Schedule: The schedule of the Plant Site. (A Plant Site can trade any kind of scheduled 

chemicals, irrespective of its schedule). An Export/Import entity is not associated to any 

specific schedule. 
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Chemicals associated to the facility selected 
 

The lower part of the “Main Pane” shows the chemicals added to the currently selected facility. 

 

 CAS Number: The CAS Number of the chemical 

 Chemical Name: The Chemical Name. 

 Schedule: The schedule of the chemical 

 Add new chemical: Opens the chemicals list dialog box that can be used to add new 

chemicals to the declaration of the facility. 

 Remove chemical: Removes the selected chemical from the declaration. Note: This is only 

applicable if the chemical has been added manually in the AND module (indicated with the 

 symbol). 

 

Activities to be declared 
 

The bottom part of the “Main Pane” shows the AND activities to be declared for the selected facility 

and chemical.  The Pane includes total export, total import, total production and, for schedule 2 Plant 

Sites, total processing and consumption, as well as the quantitative specification of amounts imported 

and exported by country. 

 

SStteepp  bbyy  SStteepp::  HHooww  ttoo  ddeeccllaarree  aa  CChheemmiiccaall  

1. Open the AND module (Data >Aggregate National Data – by facility (automatic mode) or  

shortcut: Ctrl + A 

2. Select the facility to which you want to add declaration information, or use the Add New 

Facility button to add a new facility to the declaration. In this case a list of available facilities 

will be displayed. Select the facilities to be included in the declaration, then press the 

Declare Selected Facilities  button. 

3. The selected facilities are added to the “Main Pane.” Close the facility list window. 

4. Select a facility from the “Main Pane.” The list of chemicals associated with the facility to be 

included in the aggregation of AND will be shown in the lower part of the pane. 

5. To add a chemical to the list, click the  Add New Chemical button to the right of the list. 

The Chemicals list window will be opened.  

6. Check the Chemicals that you want to declare. You can search for a specific chemical using the 

CAS Number or Chemical Name, and filter the list by Schedule, commonly traded chemical, 

chemical previously declared by any Plant Site, or chemical previously declared for the current 

Plant Site and declaration year. 

7. Click on the Declare Selected Chemicals button in the toolbar 

8. The selected chemicals will be added to the list of chemicals for the selected facility. Close the 

Chemicals List window. 

9. In the lower part of the “Main Pane”, select a chemical from the list;  the AND information will 

be displayed in the bottom level of the pane. 

10. Enter the information related to the selected chemical. 
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AND window Automatic Aggregation Mode – adding a chemical to a facility 

 

 

Reviewing Aggregate National Data 

EDNA provides a number of options for reviewing activities contained in the AND declaration. 

 

Clicking View Aggregate National Data in the toolbar of the “Main Pane” opens a window listing 

all chemicals included in the AND declaration. Clicking on a chemical will display total export, total 

import, total production and, for schedule 2 Plant Sites, total processing and consumption as well as the 

quantitative specification of amounts imported and exported by country for that chemical. 

 

Right-clicking on a chemical opens the context menu to set the classification level. 

 

Right-clicking on a data field opens the context menu to set the classification for the individual field. 

 

 

AND window Automatic Aggregation Mode - View Aggregate National Data 
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  OOCCPPFF  MMoodduullee  

 

Where to find it? 

 Data > OCPF (Shortcut: Ctrl + O) 

The OCPF module is used to add DOC/PSF Plant Sites to the declaration and to enter the relevant 

declaration data.  

The module maintains the list of Plant Sites currently added to the declaration. When a Plant Site is 

selected in the “Main Pane”, the information related to that Plant Site is displayed together with the 

declaration history of the Plant Site and any applicable warnings. 

In the bottom left pane of the screen users can select the “Plant Site Info”, the “OCPF Declaration” 

and the “Production by PSF Plants” tab.  

The “Plant Site Info” tab displays information for that Plant Site. The information can be edited and 

saved in the “Plant Site Data”. 

The chemical information to be declared for the Plant Site is entered via the “OCPF Declaration” and 

“Production by PSF Plants” tabs. 

 

 

OCPF Plant Site declaration window 
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Tool Bar 

 Add Plant Site to the Declaration: Opens the Plant Sites list to add Plant Site(s) 

to the current declaration. 

 Remove Plant Site from Declaration: Deletes the Plant Site currently selected  

from the list of Plant Sites to be declared. 

 Comments: Opens the comments window for comments that are to be attached to 

the currently selected OCPF Plant Site. 

 

OCPF Forms List 

The top part of the “Main Pane” shows the Plant Sites added to the current declaration. 

 Code: The Plant Site code. 

 Plant Site Name: The name of the Plant Site 

 Inspectable: A calculated field that shows whether that Plant Site is inspectable, based on the 

information entered into the system. 

 

   SStteepp  bbyy  SStteepp::  HHooww  ttoo  ddeeccllaarree  aann  OOCCPPFF  PPllaanntt  SSiittee  

 Open the OCPF module (Data > OCPF or shortcut: Ctrl + O) 

 Click Add New Plant Site in the toolbar. The Plant Sites list will be opened 

 When running EDNA for the first time, or when declaring a Plant Site not yet contained in the list 

of Plant Sites, click Add Plant Site to enter the new Plant Site information and add it to the list 

 Check the Plant Sites that you want to declare. You can search for a specific Plant Site using its 

code or name, or filter for a previous declaration 

 Click on the Declare Selected Plant Sites  button in the toolbar 

 The selected Plant Sites are added to the “Main Pane”. Close the Plant Sites List window 

 In the “Main Pane”, select a Plant Site from the list then add the relevant OCPF Plant Site 

information via the three tabs located in the lower part of the “Main Pane”: ‘Plant Site Info’, 

‘OCPF Declaration’  and ‘ Production by PSF Plants’ 

 Click on the tabs to navigate through the different parts of the OCPF form. Enter the required 

information related to the selected Plant Site. 
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OCPF Plant Site declaration window - adding a Plant Site to the declaration 

 

 

OCPF Plant Site declaration window – entering data through a pop-up selection window 
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  CCoommmmeennttss  WWiinnddooww  

Where to find it? 

In the toolbar of the Schedule 2, Schedule 3, OCPF and AND modules, click on Comments.  The 

Comments window will appear in the bottom pane of the program. 

The Comments window is used to add comments to the Plant Site currently selected, or to  a chemical 

in the AND declaration.  There are two types of comments: internal comments and OPCW comments.  

The internal comments are saved for internal use by the National Authority and will not be submitted 

to the OPCW. OPCW comments will be attached to the XML file containing the Electronic 

Declaration that is sent to OPCW and therefore will be viewed by OPCW as part of the declared 

information. 
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  CCoonnffiiddeennttiiaalliittyy  sseettttiinnggss  

Where to find it? 

Declaration Default 

 File > Declaration Properties to set the default confidentiality classification of the 

declaration. 

Form level 

 Right-click on the Plant Site in the main window in the Schedule 2, Schedule 3 or OCPF 

module, or on a chemical in the main window for AND – Manual Mode, and select the 

applicable classification level from the context menu.  

 For AND – Automatic Mode, open the window View Aggregated National Data and 

right-click on a chemical listed in that window to access the context menu. 

Alternatively, left-click on the left-hand part of the listing of a Plant Site or chemical. This will 

successively cycle you through the classification levels. 

Field level 

Right-click on any field and select the appropriate classification level from the context menu. 

EDNA provides three levels for setting the classification of a field: 

1. Declaration level: EDNA will use this as the default classification for the entire Declaration. 

2. Form level: EDNA will use the classification set at the form level for the fields contained on that 

form (parent form and applicable child forms) overriding the classification set at the declaration 

level. If no classification level is set at the form level, no confidentiality mark will be shown to 

the left of the listing of the Plant Site or chemical. 

3. Field level: Classification at the field level has the highest priority. It will overwrite the 

classification set on the Declaration or Form level. If no classification level is set at the field 

level, no Confidentiality mark will be added to any field. 

Classification categories and colour scheme 

 Unclassified (yellow)   

 Restricted (blue)  

 Protected (purple) 

 Highly Protected (red)   

      

 

Setting default classification for a declaration 
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Setting classification at the form level for a Plant Site 

 

 

Setting classification at the field level for a Plant Site 
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Setting classification in the window ‘View Aggregate National Data’ at the form level for a 

chemical in AND using Automated Aggregation Mode 

 

 

Setting classification in the window ‘View Aggregate National Data’ at the field level in AND 

using Automated Aggregation Mode 
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  EErrrroorrss  aanndd  WWaarrnniinnggss  

Where to find it? 

Errors 

Errors will be displayed as a pop-up window or as a marker in the applicable data entry field. 

Warnings 

The warnings applicable to the selected form will appear in the “Warnings List” in the bottom right 

pane of the window. 

The system for Errors and Warnings is active when you select a form in any module. The Errors and 

Warnings have been drawn from the validation rules used by the OPCW Verification Information 

System (VIS) to validate the forms received from National Authorities. 

Errors generally indicate an error in the data types of the values entered (such as entering text where a 

number is expected) and will prevent you from continuing data entry or moving to a new tab before 

the error has been corrected. While a large number of rules are checked by EDNA, a lack of warnings 

does not automatically indicate a completely correct declaration.  Similarly, warnings only indicate 

data that may be, but are not necessarily, incorrect. 

Warnings are at a lower severity level than errors, and generally show some logical discrepancy in the 

data. Clicking on a warning will display an explanatory text for that warning at the bottom of the 

‘Warning List’ pane and move the cursor to the applicable data entry field that will be highlighted in 

yellow. 

 

Errors will prevent a user from saving the data entered, e.g. when entering text in a data 

field where a number is expected (i.e. number of plants), or when providing a negative 

number when only positive values are valid. 
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Warnings list: Selecting one warning, the relevant data entry field is highlighted in yellow and 

the warning description is displayed in the bottom right corner 

 

 

Note: When leaving a module that has one (1) or more unresolved warnings, a pop-up 

warning message will be displayed, indicating then number of warnings present, and 

recommending that the user review these warnings. If you have already reviewed the 

content of the warnings, or if you intend to conduct the review at a later stage, click Yes. 

Otherwise, click No to stay within the current module and review the outstanding 

warnings: 
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  CCooppyy  ffrroomm  PPrreevviioouuss  ddeeccllaarraattiioonnss    

Where to find it? 

When a user selects a Plant Site in the Schedule 2, Schedule 3 or OCPF module or a chemical in the 

AND (Manual Mode) module, the Previous Declarations Pane will either indicate Select a 

declaration if the Plant Site or chemicals have previously been included in a declaration, or No 

Records in History if no declaration has hitherto been made. 

The Previous Declarations Pane will display the history of the current item.  In cases where the 

current item previously has been declared, the drop-down menu Select a declaration allows the user 

to select a previous declaration, view its contents, and copy any relevant data into the current 

declaration. 

 

 

Previous Declaration pane with the option to copy data from a previous declaration. 

 

How to use Copy to Declaration 

The Menu Select a declaration at the top of the “Previous Declarations Pane” will display a list of 

the declarations in which the Plant Site, or in the case of AND Manual Mode the chemical, has 

previously been included. Selecting one declaration will display the key information that was included 

in that declaration.  

The button Copy to Declaration allows the previously declared information to be copied to the 

current declaration. Copying the information will replace all information previously entered in the 

current declaration. In many cases the copied information must be reviewed and updated to reflect the 

current situation. 
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  EExxppoorrttiinngg  aa  DDeeccllaarraattiioonn  

Where to find it? 

 Tools > Export XML, or: 

   Tools > Export HTML 

The Export window is used to generate an electronic copy of the declaration in the form of XML or 

HTML files. 

 

 

Export Options 

 Edit field with the Browse button: The user must select a valid location for the export of the 

declaration 

 

Export File Format 

 Export HTML should be used when the output format of the exported declaration should be 

HTML. This format will be selected by default if the command activated was Export HTML 

The format can, however, be changed. 

 Export XML should be used when the output format of the exported declaration should be 

XML. This format will be selected by default if the command activated was Export XML. 

The format can, however, be changed. 

The Export option in HTML format is an effective tool for reviewing the declaration, as each form, 

together with related child forms, are exported as a separate file. This option is different from File > 

Preview Declaration which shows all forms of the current declaration in one window. 

Depending on the complexity of the declaration, the HTML export can generate a significant number 

of files. It is therefore recommended to first create a folder for the export that subsequently can be 

selected through the Browse function in Export Options. 

The export option in HTML format generates a file named ‘index.html’. Clicking the file will open a 

window in the browser listing all the forms of the declaration. Clicking on a form will open the form 

in the browser, together with its child forms if applicable,. A ‘Back to Index’ option allows the user to 

return to the window that lists all forms included in the declaration. 
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  IImmppoorrttiinngg  aa  DDeeccllaarraattiioonn  ffiillee  

Where to find it? 

 Tools > Import 

The import function allows the user to import a declaration in electronic form to EDNA or to merge 

information from two declaration files into one declaration. 

 
 

The import functions of EDNA allow for the import of declarations files in XML or CTFS format. 

These files contain only the information that is to be submitted in the declaration. Consequently, the 

detailed information entered for AND data when using automatic aggregation mode cannot be imported 

using these functions. 

 

EDNA can only import declaration files that are of the same type (ADAA or ADPA) and 

year as the declaration currently open in EDNA. 

Declaration files containing AND information (2.1 and 3.1 forms) cannot be imported if 

the aggregation mode for AND is set to “automatic” for the declaration currently open. 

The import function does not allow for the import of declaration data to a declaration that 

has been submitted. 

 

The Import of declaration files provides two main options for merging: 

1. Delete the existing declaration and import the new file. All information that has been entered 

into the declaration currently open is deleted, 

2. Merge the file to be imported with the declaration currently open. When merging an imported 

file with the open declaration there are two alternatives for handling duplicate forms for Plant 

Sites: either maintaining the original record and ignoring the duplicate form from the imported 

declaration file; or replacing the existing form with the form from the imported file.  

Note: EDNA does not check the duplication of AND forms for the same chemical. Any 

occurrence of the same chemical in duplicate entries must be handled manually after the import 

has taken place. 

 



86 

SStteepp  bbyy  SStteepp::  IImmppoorrttiinngg  aann  EElleeccttrroonniicc  DDeeccllaarraattiioonn  iinnttoo  EEDDNNAA  

1. Open a declaration or create a new declaration. 

2. Open the Import module (Tools > Import). 

3. Browse for the Electronic Declaration to be imported, select the file to be imported and click 

Open. Note that the declaration file to be imported must be of the same type and year as the 

file already open. 

4. Select the preferred merge option. 

5. Click Import. 

6. EDNA will prompt you if any errors are found that prevent the file from being imported. 
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 SUBMITTING A DECLARATION AND 

AMENDMENTS 
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  SSuubbmmiittttiinngg  aa  DDeeccllaarraattiioonn  

 

Where to find it? 

File > Submit declaration 

IMPORTANT! When creating the final declaration file to be submitted, the system adds a time/date 

stamp to the database indicating that the declaration was finalised for transmission to the Secretariat. 

Any subsequent changes will be marked as Amendments. Enter Amendment Mode when changes are 

made to a Declaration that has already been submitted.   

 

 

 

Marking a Declaration as “Submitted” means that the generated electronic file is ready to 

be transmitted to the Secretariat.  The time stamp is included in this file and used by 

OPCW as a reference point for handling amendments. 

 

Submission Window 

 

Appearance of the Submission Window (screenshot) 
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As of version 2.5, the Submission Window contains an enhanced set of data quality checks and 

controls.  

The window has five (5) main areas: 

 Top left pane: Default classification 

 The drop-down list displays the current default classification of the declaration and allows for 

another default classification to be selected prior to submission of the declaration 

 The check box requests the user to acknowledge understanding of the meaning and 

implications of the default classification. By default this box is left unchecked and has to be 

manually checked by the user before the submission can take place 

 Reminder: the default classification is the classification that will be applied to all the fields in 

the declaration, unless an explicit classification has been assigned at the form/field level, in 

which case the latter overrides any default classification that has been applied. 

 

 Top right pane: Highest classification 

 The coloured marking of the highest confidentiality shows the current highest classification of 

the declaration, and applies the same colour coding as elaborated earlier in this document. 

 The check box for acknowledging and confirming that the highest classification is by default 

left unchecked. The box has to be explicitly checked before the submission can be carried out. 

 Note: The highest classification is determined on the basis of the highest level of classification 

for the forms and fields within the declaration. It is recommended that this classification is 

clearly indicated to the TS at the time of submission. 

 

 Middle pane: Declaration warnings 

 The information displayed on the right side of the pane shows if there are any warnings in the 

declaration.  

o If there are warnings, the message will be displayed in red and will indicate the total 

number of outstanding warnings. 

o If there are no warnings, the message will be displayed in blue and will indicate that 

there are 0 warnings. 

 A grid on the left side of the pane shows each of the warnings (if any) with additional details, 

including the schedule for which the warning is generated, the relevant field, and a description 

of the warning. 

 A check box for acknowledging that warnings have been reviewed, and confirming that no 

further corrective actions are needed. The box is by default unchecked and has to be explicitly 

checked before the submission can be carried out. Note: In the case of no warnings, the check 

box is checked automatically. 

 Note: It is recommended that all outstanding warnings are reviewed prior to submission. If 

there is a to correct any of the warnings, it is recommended to click Go Back to Declaration 

and to examine the data and make the necessary corrections (if any). 

 

 Bottom left pane: Submission Package Reminder 

 

 The check box requests the user to acknowledge that the declaration package will not be 

altered and will be delivered in its original form, as created by the application. 

 

 Bottom right pane: Options 

 This declaration package is for testing purposes: indicates that the operation would not 

result in marking the declaration as “submitted” (and will hence not switch the application 
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into the “amendment mode”). This option can be used if additional quality control checks 

need to be performed prior to the “actual submission”. 

 Burn directly to CD-ROM: indicates that the submission package will be burned directly to 

a CD from inside EDNA, as an alternative to saving the files to a directory in the PC. This 

facilitates the application preparation process. 

 Adjust AND figures to schedule thresholds when submitting:
18

 allows the declaration of “< 

threshold” values for the breakdown of import/export quantities per country in the aggregate 

national data AND, as per the Decision C-7/DEC.14.  

o If checked, all individual import/export quantities per country below the declaration 

threshold will be exported in the “< threshold” format – both into XML and HTML 

generated declaration forms. 

o If unchecked, all individual import/export quantities per country below the 

declaration threshold will be exported exactly as entered in the AND module 

                                                 
18

 Only available if AND mode is set to automatic 
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  UUnn--SSuubbmmiittttiinngg  aa  DDeeccllaarraattiioonn  

 

Where to find it? 

Tools > Settings > Declarations tab 

If you have mistakenly marked the Declaration as “Submitted,” and only before transmitting the 

declaration to the TS, you may use this window to undo the action by removing the date/time stamp 

of the submission. 

 

 

 

 

DO NOT un-submit a declaration that was already transmitted to the Technical 

Secretariat.  

 

 

Un-submitting a declaration after it has been transmitted to the TS would change the 

reference date used to identify amendments.  This could eventually cause a discrepancy 

between the data imported to the VIS and the data maintained by the National Authority 

using EDNA. 
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  AAmmeennddmmeenntt  MMooddee  

 

When you are in Amendment Mode, you will notice a few changes in the user interface.  An indication 

of the Mode is displayed in the window title, and the declaration title is marked with a light yellow 

background.  

 

 

 

OCPF Plant Site declaration window in ‘Amendment Mode’ 

 

When in amendment mode, any changes carried out in the application will be recorded as amendments, 

and marked accordingly, as follows: 

 

 Newly added forms will be marked as [ADDED] in the declaration preview and in exported or 

submitted declaration forms. 

 Forms which existed in a previous year, but have had their content changed (e.g. specific 

values updated) will be marked as [UPDATED] in the declaration preview and in exported or 

submitted declaration forms. 

 Forms which existed in previous year, but are now being removed from the declaration will be 

marked as [DELETED] in the declaration preview and in exported or submitted declaration 

forms. Such forms will no longer be visible in the application data windows
19

. 

 

 

Example – display of deleted forms in the declaration preview in amendment mode 

                                                 
19

 Note that this is a change in behaviour from Version 2.1, when deleted forms would remain on the screen, with 

the “D” mark next to them. In Version 2.5 this is no longer the case, and deleted forms are not displayedt on data 

screens. 
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Example - display of added forms in the declaration preview in amendment mode 

 

 

 

Example - display of updated forms in the declaration preview in amendment mode 

 

In the preview mode for amended declarations, it is clearly indicated that the 

declaration has been amended, and the reference declaration is made apparent: 

 

 

Example - display of amended declaration in the declaration preview 

 

 
Marking of amended forms in the declaration preview and HTML output is carried out at 

the parent form level. Child forms are not explicitly marked as amended. For example, if 

an S3 plant site is removed, the top level plant site forms (3.2) will be marked as 

[DELETED], whilst its child forms (if any), will implicitly be deleted, without an explicit 

amendment deletion marking displayed on the screen. 

 

 

Hint: If you have removed a form in amendment mode and you cannot locate it in the 

declaration preview (marked as “DELETED”), ensure that no preview filters have been 

activated and that the full declaration is always shown. This should allow the deleted forms 

to appear in the preview. 

 

 

Unlike the previous EDNA Version (2.1), EDNA always exports and submits the whole 

declaration, including amendments. The option to submit only amendments, which existed 

in earlier versions, has been removed in Version 2.5, in order to simplify the submission 

process and prevent the submission errors which occasionally were experienced. 
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 DECLARATION PREVIEW 
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  SSiimmppllee  DDeeccllaarraattiioonn  PPrreevviieeww  

Where to find it? 

 File > Preview declaration 

The Preview declaration option allows you to view the entire declaration in print form. When 

activated, the application will prepare all the declaration forms (as they appear in the Declaration 

handbook), based on the data contained in the declaration. You can then easily review the information 

and check that it is correct. 

 

Tool Bar 

 ( )Advanced options: Opens (or closes) the pane, with extended options for 

declaration sorting and filtering. For more information, see section (Advanced 

Declaration Preview) below. 

 View in browser: Opens the web browser and displays the declaration preview 

within the browser. 

 Save as web page: Saves the content of the declaration preview into an external web 

file, for subsequent review in a web browser 

 Print: Opens the standard print dialog from which declaration forms can be printed 
 

 

Preview declaration window  
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  AAddvvaanncceedd  DDeeccllaarraattiioonn  PPrreevviieeww  

Where to find it? 

 Tools > Advanced declaration preview 

Advanced declaration preview option allows the user to view how the declaration appears on the 

page, and to choose which parts of the declaration and in which order information should be 

displayed. When activated, the application will prepare all the declaration forms (as theyappear in the 

Declaration handbook), based on the data contained in the declaration and on the configuration 

criteria used in advanced options.  

 

Tool Bar 

 ( )Advanced options: Opens (or closes) the pane and provdes extended options 

for sorting and filtering declaration data. 

 View in browser: Opens the web browser and displays the declaration preview 

within the browser. 

 Save as web page: Saves the content of the declaration preview into an external web 

file, for review later on, in a web browser 

 Print: Opens the standard print dialog from which the declaration forms can be 

printed 

 

Advanced options – Filters 

Filters allow you to select which parts of the declaration should be displayed. You can combine 

different filters to personalise the filtering process. Note that filtering certain forms out from the 

preview does not have any impact on the actual declaration data. All the data and all the forms 

remain in the declaration, but only those you have selected are displayed in the preview window. 

 Full declaration (no filter): If checked, the full content of the entire declaration will 

be displayed, regardless of any previously configured filters 

 Aggregate National Data only (S2 and S3): If checked, only the AND related forms 

will be shown 

 By regime: Allows filtering of the displayed content per selected regime (Schedule 2, 

Schedule 3, OCPF or any combination of these three) 

 By plant site code: Allows filtering of the displayed content to show only forms 

related to the selected plant sites, identified by the plant site code 

 By chemical: Allows filtering of the displayed content to show only forms related to 

the selected chemicals, identified by the chemical IUPAC name 

 By plant site owner: Allows filtering of the displayed content to show only forms 

related to the selected plant sites, identified by the plant site owner 

 

Advanced options – Sorting 

Sorting allows the user to select the order in which declaration forms should be displayed. Note 

that sorting flexibility is limited, in order to respect the structure of declaration forms in 

accordance with the Declaration handbook. 

 Sort forms by plant site code: If selected, forms related to plant sites within a single 

regime will be sorted in ascending order, according to the plant site code 

 Sort forms by plant site code: If selected, forms related to plant sites within a single 

regime will be sorted in ascending order, according to the plant site owner 
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 Sort forms by plant site code: If selected, forms related to plant sites within a single 

regime will be sorted in ascending order, according to the plant site code 

 Then by Chemical CAS#: If selected, sorting of forms related to chemicals will be 

done in an ascending order, based on the chemical CAS number 

 Then by Chemical IUPAC name: If selected, forms related to chemicals will be 

sorted in ascending order, based on the chemical IUPAC name 

 
If filtering and. or sorting options are modified, click the View declaration button (circled 

below in red marking) to activate the options and display the declaration content according 

to the selected options. 

 

 

Advanced declaration preview window  
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 ANALYTICAL REPORTS 
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  AAnnaallyyttiiccaall  RReeppoorrttss  

Where to find it? 

 Reports > Analytical Reports 

Analytical reports provide the ability to users to analyse data from the current or previous 

declarations. A collection of pre-defined reports has been developed, allowing various data analysis 

capabilities focused on different aspects of the declaration data. Reports generated in this way can be 

viewed on the screen, filtered and sorted, and printed or exported for further analysis in external 

analytical tools. 

 

Tool Bar 

 Report menu or Report selection drop down list: These options allow the user to select the 

report type to be displayed.  

 Show Report:  Displays the data from the selected report on the screen. 

 Print: Opens a standard print dialog for setting up and printing the content of the selected 

report. 

 Save To Excel: Allows export of data from the currently selected report into an Excel 

compatible format, for further analysis. 

 Drag column header here to group by that column: A special area of the report window 

that allows the user to drag any of the columns from the currently displayed report, in order to 

group data on the basis of user-defined criteria 

 

 

Typical analytical report window  

 

Hint: To change the order of columns, click a column header and drag it to the left or right. To 

change the column width, drag the edges of the column header to the left or right, as needed. 
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Types of reports 

 Declaration Plant Sites by Regime: A report showing a simple breakdown of the 

number of declared plant sites per regime (Schedule 2, Schedule 3 and OCPF) in the 

declaration that is currently open on the screen (current declaration). 

 Schedule 2 Plants: A report showing a summary of Schedule 2 plants declared in the 

current declaration 

 Schedule 3 Plants: A report showing a summary of Schedule 2 plants declared in the 

currentl declaration 

 Schedule 2 Past Activities: A report showing a summary of past activities of 

Schedule 2 plants declared in the current ADPA declaration 

 Schedule 3 Past Activities: A report showing a summary of past activities of 

Schedule 3 plants declared in the current ADPA declaration 

 Schedule 2 Anticipated Activities: A report showing a summary of anticipated 

activities of Schedule 2 plants declared in the current ADAA declaration 

 Schedule 3 Anticipated Activities: A report showing a summary of anticipated 

activities of Schedule 3 plants declared in the current ADAA declaration 

 OCPF Declaration Summary: A report showing a summary of all the OCPF sites 

and related activities, as declared in the current ADPA declaration 

 OCPF Comparison with Previous Declaration: A report showing a side-by-side 

comparison of the OCPF plant sites and related activities, as declared in the current 

and previous ADPA declarations. 

 Trade Summary (Manual Mode): A report providing an overview of import and 

export quantities per country, as declared in the current declaration using the manual 

AND aggregation 

 Trade Summary (Automatic Mode): A report providing an overview of import and 

export quantities per country, as declared in the current declaration with the automatic 

AND aggregation 

 Aggregate National Data (Automatic Mode): A report showing an overview of 

Aggregate National Data in the current declaration with the automatic AND 

aggregation 

 

Operations with data in analytical reports 

 Sorting: To sort data shown in the report based on specific filter criteria, click on the 

column header of the column you want to sort. The arrow which appears alongside 

the column title will indicate the sorting order (ascending/descending). To change the 

sorting order, click the column header once again. 
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Analytical report sorted by Chemical name, in ascending order  

 

Analytical report sorted by Quantity Imported, in descending order  
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 Filtering: To filter the data, click the  icon in the column header, and select the 

required values from the drop-down list . 

 

 

Setting filters in analytical reports 

 

 

 Custom filtering: To filter using more advanced options, click the  icon in the 

column header and select Custom from the drop-down list. From the custom filtering 

window, configure one or more filter criteria and click OK to confirm. 

 

 

Configuring advanced filter criteria in the custom filter set-up window  
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Hint: When the column filter is active, the filter symbol will be displayed in blue: . To 

switch off the filtering function, click the blue filter symbol  and select All from the 

drop-down list of filter options. All the data available in the column will be displayed, and 

the filter symbol will change back to the original grey colour: . 

 

 

Analytical report with active filter (on Chemical column) 

 

 Grouping: To group data according to one or more criteria, click the header of the 

column by which you want to group, and drag the cursor to the area just above the 

data table. 

 

 

Trade summary analytical report grouped by Country 
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Hint: You can group by more than one column by using the same principle of clicking and 

dragging a column header to the grouping area. 

 

 

Trade summary analytical report grouped by two columns (Chemical, then by Country) 

 

Hint: To ungroup, click a column in the grouping area and drag it away from the area. 
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 MAINTENANCE TASKS 
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  DDaattaabbaassee  TTaasskkss  

Where to find it? 

 Tools > Database Tasks 

‘Database tasks’ provides an easy way to backup and restore the EDNA database directly from the 

program when the database is hosted on a local machine.  

 

When the EDNA Database is hosted on a remote database server in your network, the   

application is unable automatically to backup and restore data. The organisation’s IT 

department will need to perform these tasks on your behalf. It is highly recommended to use 

local databases, unless your organisation employs technical staff with knowledge of 

database administration and backup/restore operations. 

 

 

Backup Database: 

Saves a backup of the EDNA database in the folder %PROGRAMDATA%\EDNA\Backups.  The 

database retains all the backups performed by the application, identified by date and version. 

 

Backing up your database is a crucial task that should be performed regularly by EDNA 

users.  EDNA periodically will prompt you to perform this task. 

 

When backups are performed by EDNA, the backup file will reside in the SQL Server 

folder (normally C:/Program Files/Microsoft SQL Server/MSSQL.1/MSSQL/DATA). 

These files should be copied manually to an external device on a regular basis, in order for 

them to be restored whenever necessary. 

 

Restore Database: 

This feature provides users with the option of restoring one of five previously saved backups. 

 

 

Restoring the database will OVERWRITE any data currently saved in the EDNA 

database.  Make sure to use this feature with extreme caution. 
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  EErrrroorr  LLoogg  

Where to find it? 

 Tools > Export > Error log 

This is a straightforward option for saving the application error log which contains technical 

information about the functioning of EDNA, as well as any errors that may have occurred during the 

use of the application. This information may of assistance to the Technical Secretariat’s EDNA 

technical support personnel, for support and troubleshooting 

 

Export Error Log: 

Should you encounter problems while using EDNA, or if errors or irregular application behaviour are 

observed, you are advised to contact the Secretariat’s EDNA support team. If instructed by the team to 

provide an error log, for the purpose of troubleshooting, please follow the following procedure: 

1. From the menu Tools select Export and then Error log 

2. Select the location where the log will be saved 

3. Wait for the following confirmation to appear: 

 

4. Navigate to the location where the file has been saved, check that the file exists and, if 

required by the technical support team, transmit the report to the Secretariat for analysis.  

Note: Before transmitting the error log to the Secretariat, it is advisable to browse through 

the document to ensure that it contains no confidential information. Note that the file will 

contain technical details that will be deciphered by the TS EDNA support team. 
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 TECHNICAL SUPPORT 
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The Secretariat stands ready to provide support for National Authorities in the use of EDNA. The 

primary means for contacting the Secretariat, for EDNA support purposes, is via the dedicated email 

address vis@opcw.org 

For urgent enquiries the EDNA help desk is available at the OPCW central telephone number +31 

(0)70 416 3300. 

 

mailto:vis@opcw.org

